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Introduction
This is a user guide for Qwizdom Mac Connect. This guide provides information and tips
on using Qwizdom Mac Connect.
If you need assistance, please contact Technical Support.

2

Website

www.qwizdom.com

Tech Support

(253) 770-1285

Email

support@qwizdom.com

Support Hours

6 a.m. to 4:30 p.m. PST

Address

Qwizdom, Inc.
12617 Meridian East
Puyallup, WA 98373

Getting Started
Contents of Remote Set
Q2RF, Q4RF, or Q5RF remotes*
1 HID or RF host
1 Q5RF instructor remote or 1 Q7RF instructor tablet*
1 USB cable
1 Charger (Q5RF Instructor Remote)*
1 Multi-charger (Q5RF Remotes)*
1 Screwdriver
AA Batteries (Q4RF) or AAA Batteries (Q2RF)*
1 Remote carrying case
1 Quick Reference guide
1 Software; Qwizdom Mac Connect
*Remote types and accessories based on actual order. This device complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

2.1

Notice
Notices of Compliance for Qwizdom's RF Response Devices
Note: This equipment has been tested and found to comply with the limits for a Class B
Qwizdom Mac Connect 2010
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digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:
· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.
· Consult the dealer or an experienced radio/TV technician for help.
Caution: Changes or modifications to Qwizdom's RF hardware that are not expressly
approved by Qwizdom could void the user's authority to operate the equipment.

This product is designed for the 2.4 Ghz WLAN network throughout the EC region and Switzerland with restrictions in France.

2.2

Installing Qwizdom Connect
System Requirements
PPC G4 processor and Intel
OS X 10.4 and later
512 MB RAM
10 GB Free Disk Space
CD-ROM drive
Open USB Port

Installing Qwizdom Mac Connect from CD
If you have the RF host, plug the USB cable into the RF host and then plug the other end of
the USB cable into an open USB port before installing Qwizdom Connect. The USB drivers
are located in the Qwizdom Connect installer and should auto-install if it detects the RF
host.
1. Insert the Qwizdom Mac Connect disc into the CD-ROM drive, follow the Install
Connect wizard.
2. Click Continue in the Introduction.
3. Click Continue in the Read Me.
4. Read the Software License Agreement and click Continue.
5. Click on Agree to agree to the terms of the Software License Agreement.
6. In Select a Destination, select where Mac Connect will be installed and click
Qwizdom Mac Connect 2010
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Continue.
7. Click Install to begin installation. This will take a few moments.
8. Once the installation is complete, click Close and restart your computer (if
necessary).

2.3

Hardware Setup
1. Place two AA batteries (provided in the remote set) and insert the screw (optional)
into the back of the Q4RF remote to secure the battery compartment; or place two
AAA batteries (provided in the remote set) and insert the screw (optional) into the
back of the Q2RF remote to secure the battery compartment. Plug the Q5RF
participant and instructor remotes into the multi-charger and/or single charger for
24 hours before first use.
2. For the tablet, see below.
3. Enter session ID and assigned fixed remote IDs. See Remote Setup for more
information.

Installing the (red) RF Host
1.
2.

Plug the (red) RF host into an open USB port on the computer using the supplied
USB cable.
The computer will automatically detect and configure the new hardware device.

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Installing the (black) HID host
1. The HID host is located in the back compartment of the Q7RF tablet.
2. Plug the HID host into an open USB port on the computer.
3. The computer will automatically detect and configure the new hardware device.

Qwizdom Mac Connect 2010
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This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Charging the Q7RF Tablet and Pen
The tablet needs to be charged a full 24 hours for the first time or after a long period of
inactivity. The pen may take slightly longer to fully charge. Generally, the tablet will only
need to be charged about 6 hours to be fully charged after the initial charge.
1. Place the pen into the pen tray located at the top of the Q7RF tablet.
2. Using the USB cable, plug the tablet into the computer.
NOTE: If your computer goes into power saving mode, the charging of the Q7RF
tablet may be interrupted.
3. The battery icon will be full when the tablet is fully charged.

Session ID
A session ID is the host's unique identifying number. The session ID enables the tablet to
communicate with that specific host to which the ID is assigned. If the tablet remote
displays host Not Found, it could be either that the session ID is incorrect or the host isn't
Qwizdom Mac Connect 2010
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active.
1.
2.
3.
4.
5.

2.4

Launching Qwizdom Mac Connect
1.

3

Press the Menu key.
Use the Scroll button to select Enter Session ID.
Press the Enter key to select it.
Enter the session ID.
Press the Enter key to confirm.

Click the

Qwizdom Tools.

Remote Setup
Follow the steps below to set up remotes. Be sure the HID or RF host* is properly installed
before proceeding.
v.938 host or higher is required for Qwizdom Connect. If the host is not v.938 host or higher, please contact
Technical Support.

· Estimated Maximum Number of Remotes-the number of remotes that will
be in use for the presentation. Class/group sizes vary, so it's best to enter the
highest estimated amount of remotes rather than accommodating each
class/group.
· Enable Backlight-activates the back light on the Q5RF participant and Q5RF
Instructor Remotes.
· RF host (Red Base)
· HID RF host (Black Base)
· Set with fixed remote ID-select this mode if you are in a K-12 or Corporate
setting. Fixed Set is where the remotes are assigned with an internal number
(assigning fixed numbers) where logging in by ID is not mandatory.
Qwizdom Mac Connect 2010
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6.
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· Roaming Set or Participant Owned-check this option if the participants own
the remotes. This mode is best-suited for Higher Ed/University settings.
Participants are required to either enter a session ID or participant ID to join a
presentation.
Click the Remotes menu.
Select Configuration Preferences. The Remote Preferences window opens.
Enter the maximum number of remotes that will be used.
Select the host type.
Depending on the setting, select Set with Fixed Remote ID or Roaming
Set/Participant Owned. If you select Set with Fixed Remote ID, see Assigning Fixed
Numbers below.
Click OK.

Session IDs
When using RF Remotes for the first time, the remotes may ask for a session ID. Each host
has a unique six-digit session ID. Session IDs "assign" the remote to the host, allowing the
remote to only communicate with that specific host. The session IDs can be found:
· For both HID and RF host, the session ID can be found in the Assigned Fixed Remote
IDs window and the Login tab in the Presentation Setup window.
· For the RF host, the session ID can be found on the bottom of the device on a
white sticker.
You can also create your own session ID in the Presentation Setup window by entering a
session ID you want to use in the User Session column. Creating your own session ID does
not change the host's default session ID. The session ID must be unique because if there
are other hosts in the same building, the remotes will become confused as to with which
host to communicate.

Assigning Fixed Numbers
Assigning fixed numbers assigns the remote ID (e.g. remote #1, remote #2, etc.). The file that
contains the remote assignments is saved onto the computer, not on the remotes. You
only have to assign fixed numbers once, unless you change computers or hosts.
1. Go to the Remotes menu.
2. Select Configuration Preferences. The Remote Preferences window appears.
3. Enter the maximum number of remotes that will be in use.
4. Select the host type.
5. Select Set with Fixed Remote ID.
6. Click Assigned Fixed Remote IDs. The Remote Assignment window will appear.
7. Read the instructions and click the Start button.
8. Turn the remotes on. When the remotes communicate with the host, the serial
number and the remote's assigned ID number will appear in the window. If the
remotes are prompting for the session ID, enter the session ID that is displayed at
the bottom of the Assign Fixed Remote ID window.
Qwizdom Mac Connect 2010
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8.

After all the remotes have been assigned, click Done to exit the Assigned Fixed
Remote IDs window.

Changing Session IDs
If the RF remote or tablet displays No Net, Not Found, Not Active, or Inactive, it could be that
the session ID is not correct.
· For Q2RF remotes: wait for the remote to time out and turn off. When you turn it
back on, press the Help key. When you see --S on the display, it is prompting you for
the session ID. Enter it and press the Send key to confirm.
· For Q4RF remotes: press the Menu key, use the right arrow to scroll to Sess. ID., and
press the Send (double arrows) key to select the option. You will see the current
session ID and will be asked if you want to change the session ID. Press T (Yes) to
change. Enter the session ID and press the Send (double arrows) key to send.
· For Q5RF remotes: wait for the remote to display No Net, Not Active, or Not Found.
Press the Menu key and select Enter Session ID using the Send (double arrows) key or
the circle key on the thumb pad. Enter the session ID and press the Send (double
arrows) key.
· For Q7 tablet: press the Menu key and use the Scroll button to select Enter Session ID.
Press the Enter key to select it and enter the session ID. Press the Enter key to confirm.

3.1

Notice
FCC 15.19:
(3) All other devices shall bear the following statement in a conspicuous
location on the device.
This device complies with Part 15 of the FCC Rules. Operation is subject to
the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

FCC 15.21:
The user's manual or instruction manual for an intentional or unintentional
radiator shall caution the user that changes or modifications not expressly
approved by the party responsible for compliance could void the user's
authority to operate the equipment. In cases where the manual is provided
only in a form other than paper, such as on a computer disk or over the
Internet, the information required by this section may be included in the
manual in that alternative form, provided the user can reasonably be
expected to have the capability to access information in that form.

FCC 15.105:
Qwizdom Mac Connect 2010
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(b) For a Class B digital device or peripheral, the instructions furnished the
user shall include the following or similar statement, placed in a prominent
location in the text of the manual:
NOTE: This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications.
However, there is not guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:
-- Reorient or relocate the receiving antenna.
-- Increase the separation between the equipment and receiver.
-- Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.
-- Consult the dealer or an experienced radio/TV technician for help.

3.2

Q2RF
Participant Remote

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
Qwizdom Mac Connect 2010
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undesired operation.

1.

E inkä display-displays the remote's ID number when it is turned off; displays
remote's ID number and battery icon when it is turned on.

2.

Navigation
arrows-scroll through question numbers. Left arrow
also used as a backspace.
True/Yes, False/No keys-use to answer True/False and Yes/No questions.
Multiple Choice and Numeric keypad-answer multiple choice and numeric
questions (with single digit answers).

3.
4.

3.3

is

5.

Join

key-press to turn remote on/off or confirm session and/or user IDs.

6.

Help
key-press to request assistance or press to change session ID when the
remote cannot find the host.

Q4RF
Participant Remote

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

1.

Send

key-press to submit answer or select menu options.

2.

Menu [power] key-press to view menu options (use the scroll
scroll through options and press Send

keys to

key to select the option). Holding the
Qwizdom Mac Connect 2010
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Menu key for two seconds will turn the remote on/off. Turn off remotes if they are
not in use. Remotes automatically turn off at the end of a PowerPoint®
presentation. Search, Sess. ID, User ID, and Exit are options available in the menu.
When you're in presentation, the menu items are Help, Login, User Id, and Exit. To
request help during presentation, press the Menu key, scroll to select Help, and
press the Send
3.
4.
5.

key to select it.

Scroll
keys-scroll through menu options, answer choices, or question
numbers.
[C] Clear key-press to delete response or change answers if instructor has enabled
the feature.
True/Yes and False/No keys-use to answer True/False and Yes/No questions.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

3.4

Q5RF
Participant Remote

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

1.
2.
3.

4.

Send
key-press to submit answer.
[C] Clear key-press to delete response or change an answer in a presentation (if
option to change responses is allowed).
Thumb pad-press to navigate between letters when keying in answer, press the
circle key in the middle to select a letter or to select menu options or to scroll
through question numbers during answer keys (paper-based tests).
Question [?] key-signals help to instructor during presentation.

Qwizdom Mac Connect 2010

13

Qwizdom Mac Connect User Guide

5.

Menu key-displays menu options Search Again, Enter Session ID, and Exit. Use the

6.
7.

thumb pad to scroll through the menu options and the Send
key or circle key
to select an option.
True/Yes and False/No keys-use to answer True/False and Yes/No questions.
Power switch-turns remote on/off. The remotes do not automatically turn off.
Turn off remotes if they are not in use.
Light switch-turns Backlight on/off.

8.

Q5RF Instructor Remote (this is the Instructor Remote for Q4 and Q5 participant
remotes)

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

1.
2.
3.

4.
5.
6.
7.
8.

Send
key-press to submit command.
C [Clear] key-press to clear names from the Help Request list.
Thumb pad-press right/left to navigate between slide sets, up/down for menu
options, and spontaneous question choices. Press the circle key (in the middle) to
select an option, advance slides, exit the presentation, and show/hide correct
responses on the response graph.
? [Help List] key-displays list of participants who requested help on the LCD screen.
Menu key-view menu options such as entering session ID and search again for
host.
True/Right and False/Wrong keys-use to select answer for True/False and Yes/No
questions.
New Q [-] key-press to pose a spontaneous question.
Pick (.) key-press to display/hide a random participant's name on the computer
screen.
Qwizdom Mac Connect 2010
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Private Graph
(0) key-displays the results of the class responses as a graph on
the LCD screen of the instructor's remote.

10. Public Graph
(/) key-displays the results of the class responses as a graph on
the computer (projector, television screen, etc.) screen for everyone to view. Use
the right/left controls on the thumb pad to scroll through the different graphs.
Use the circle key (in middle of thumb pad) to show/hide correct responses.
11. Show [7] key-displays animations during game presentations.
12. Play [8] key-will play animation/sound in Connect only.
13. Fn [Function] key-allows you to re-pose a question if you go back during to a
previous slide during presentation-previous answers will be overwritten.
14. Power switch-turns remote on/off.
15. Light switch-turns Backlight on/off. The "Enable Backlight" box in the Configuration
Settings window needs to be checked to turn on the Backlight feature.

3.5

Using Remotes in Presentation
Q5RF Instructor Remote Tips
·

The Q5RF Instructor Remote will display Ready or Last Key.

·

Since the Q5RF Instructor Remote is not applicable during answer keys, the LCD
screen will display Access Denied.

·

Press the / key on the Q5RF Instructor Remote to display the response graph.

·

Press the / key on the Q5RF Instructor Remote to close the response graph.

·

Press the 0 key on the Q5RF Instructor Remote to display the graph on the
instructor's LCD.

·

Press the Pick (.) key on the Q5RF Instructor Remote to randomly call upon a
participant during presentation.

·

Press the 1 (A) key on the Q5RF Instructor Remote to go to the next question in Fast
Track/Mars Mission games.

·

Press the Show (7) key on the Q5RF Instructor Remote to show current scores of
participants/group during game mode.

·

Press the New Q (-) key to pose a spontaneous question. A list of question types will
appear on the LCD. Use the up/down arrows on the thumb pad to navigate
through the question types. Press the Send key to select the question type. Select
the correct answer and press Send; if the answer is survey only, press the Send key
without selecting an answer.

Qwizdom Mac Connect 2010
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·

Press the ? key to display the list of participants who have requested help.

·

Press the circle key, in the thumb pad, to close out of the presentation (must be on
last slide), move to the next slide, or display/hide the correct answer on response
graph.

Participant Remote Tips
·

Qwizdom will be displayed on the Q4RF and Q5RF remotes when a lesson (nonquestion) slide is in view.

·

For Q4RF and Q5RF remotes, participants will either see answer choices or a blank
screen (depending on question type) on their remote during a question slide. For
Q2RF remotes, participants will see a blank screen with a battery icon.

·

To request help on the Q4RF and Q5RF remotes, press the Menu key to select Help
and press Send. For Q2RF remotes, press the Help (Hand) key.

·

To change the session ID on the Q4RF remote, press the Menu key and use the right
arrow to scroll through the menu options. When you see Sess. ID, press the Send key
to select it. An existing session ID may appear and the remote will ask if you want to
change it. Press T for yes and enter the new session ID. Press the Send key to
confirm.

·

To change the session ID on the Q5RF remote, press the Menu key when the remote
displays No host Found. Use the thumb pad to navigate through the menu options
and press the Send key to select Enter Session ID.

·

To change the session ID on the Q2RF remote, when the remote is on, wait for the
remote to time out and turn off. When you turn it back on, press the Help key. When
you see --S on the display, enter the session ID and press the Send key to confirm.

·

To change the user ID on the Q4RF remote, press the Menu key and use the right
arrow key to scroll to User ID. An existing user ID may appear and the remote will
ask if you want to change it. Press T for yes and enter a user ID. Press the Send key to
confirm.

·

The LCD screen on the participant remotes may read Push Key, Inactive, or Not
Active, press the Send (double arrows) key to "wake up" the remote. If the remote
still displays Not Active, re-enter the session ID.

·

If the Q4RF displays No Net, or the Q5RF remote displays host not found, or the Q2RF
remote displays - - - and turns off, re-enter the session ID. Go to Changing Session
IDs for more information.

Qwizdom Mac Connect 2010

Remote Setup

·

16

If the Q4RF remote displays Denied, or the Q5RF remote displays Access Denied, or
the Q2RF remote displays --U, the participant ID is incorrect, or the Remote ID
attempting to participate isn't in the participant list that was loaded. Re-enter the
participant ID, and check to make sure that Remote ID is in the participant list.

Below are the procedures on how to respond for each question type during presentation:
· True/False-select T or F and press the Send key.
· Yes/No-select Y or N and press the Send key.
· Multiple Choice-select A, B, C, D, E, or F and press the Send key.
· Multiple Mark-select the letter choices and press the Send key.
· Numeric-enter the numbers and press the Send key.
· Sequence-enter the numbers in the correct order and press the Send key.
· Multiple Answer-List-press the letter choices and press the Send key.
· Fill-in/Completion-for Q5 remotes only-for one answer you will see:
1)___________________
*)Send
Make sure 1) is highlighted and press either the Circle or the Send key to select it.
1)_______________ will appear on the LCD. Press the Menu key to display the
alphabet. Use the arrows on the thumb pad to navigate through the letters, using
the Circle key to select the letter(s). Press the Send key when finished entering the
answer. You will see 1)your answer. Press the down arrow on the thumb pad to
select *)Send and press the Send key to confirm the answer.
For two answers, you will see:
1)___________________
2)___________________
*)Send
Make sure 1) is highlighted and press either the Circle or the Send key to select the
question number. 1)__________ will appear on the LCD. Press the Menu key to
display the alphabet. Use the arrows on the thumb pad to navigate through the
letters, using the Circle key to select the letter(s). Press the Send key when finished
entering the answer. You will see 1)your answer.
Press the down arrow on the thumb pad to select 2)__________ and press the Circle
or Send key to select the question number. 2)__________ will appear on the LCD.
Press the Menu key to display the alphabet. Use the arrows on the thumb pad to
navigate through the letters, using the Circle key to select the letter(s). Press the
Send key when finished entering the answer. You will see 2)your answer.
Press the down arrow on the thumb pad to select *)Send and press the Send key to
Qwizdom Mac Connect 2010
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confirm the answers.
·

4

Short Answer-Specific; for Q5 remotes only. The alphabet menu will automatically
appear when this question type is displayed. Use the arrows on the thumb pad to
navigate through the letters, using the Circle key to select the letter(s). Press the
Send key to confirm your answer.

Q7RF Tablet
Instructor Tablet

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The active area of the Q7RF Instructor tablet acts as an absolute position mouse or
standard mouse, controlling standard keyboard shortcuts such as:
· copy, paste, and delete
· navigating presentations

Qwizdom Mac Connect 2010
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File Browser-opens file browser window

Time tool-adds additional time
to timer

New Item-creates new slide, file, or document
depending on application (acts like Control + N)

Private Graph-displays private
graph of responses on tablet

Open-browse and open files (acts like Control +
O)

Public Graph-displays
response graph to participants

Copy-copies selected object(s) (acts like
Control+C)

LCD Backlight-turns backlight
on or off

Paste-pastes copied object(s) (acts like
Control+V)

Pen tool-use to draw

Undo-undo last action(s) (acts like Control+Z)

Highlighter-use to highlight

Redo-redo previous action(s) (acts like Control +

Line tool-use to draw lines

Delete-deletes selected object(s)

Text tool-use to create text

Y)

Media Control-play and pause presentations and
Insert Multimedia-inserts
multimedia files
images, audio, and video files
Pick-picks random participants

Window Shade-covers (hides)
what is displayed on the computer
screen (portion or all)

Show Presentation-displays game animation
when in a game mode presentation

Laser Pointer-displays laser dot
when using the pen

Help Requests-displays list of participants who
requested help on LCD screen

Absolute Position Mousedisplays arrowhead when using the
pen and works as an absolute
position mouse*.

Insert Slide-creates slides for presentation

Mouse-operates pen with
mouse functions as it changes to
standard mouse mode from
absolute position

Pose-use to pose or repose a question

Keyboard tool-activates
keyboard region

Stop-stops the question being posed

Function tool-lock/unlock
functions for freehand. Access userdefined list of functions
*Absolute position mouse is where the cursor will appear on the screen exactly where the
pen is positioned on the tablet.
Qwizdom Mac Connect 2010
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Volume Control
For Numeric question types
For Multiple Choice question types
For Rating question types
For Yes/No or True/False question types

Pen (for Q7RF Instructor Tablet)

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The pen is used as a mouse that can left-click, right-click, and double-click to execute
commands and actions on the Q7RF Instructor tablet.

USB host (for Instructor Tablet)

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The USB host is used to collect data from the remotes and record into the Qwizdom
software. This USB host does not require driver installation.

4.1

Using the Q7RF Tablet
New Item-creates new slide, file, or document depending on application
Open-browse and open files
File Browser-opens file browser window

Qwizdom Mac Connect 2010
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Copy-copies selected object(s)
Paste-pastes copied object(s)
Delete-deletes selected object(s)
Pose-poses question slide
Insert Slide-creates slides for presentation
Stop-stops the question being posed
Window Shade-hides portion of displayed screen
You must be in Presentation Mode to utilize the features on the tablet.

Creating Slides
1.
2.
3.
4.
5.
6.

Press the New Question icon on the tablet. A list of question types will appear on
the tablet's LCD.
Use the Scroll button to navigate through the different question types.
Select one and press Enter.
Use the pen to select or enter a correct answer using the answer choices, located
at the bottom of the tablet.
Draw or enter text and/or multimedia onto the slide.
Press the Send key to pose the question.

Window Shade
Window Shade hides (covers) what is being displayed on the computer screen (portion or
all).
1. Press the Window Shade icon on the tablet. A window shade will cover the
computer screen.
2. Use the Scroll button to navigate through the different question types.
3. Select one and press Enter.
4. Use the pen to select or enter a correct answer using the answer choices, located
at the bottom of the tablet.
5. Draw or enter text and/or multimedia onto the slide.
6. Press the Send key to pose the question.

Qwizdom Mac Connect 2010
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Using the Pen
The pen is used (with the tablet) to write, draw, and control mouse movements.

Pen tip-same as a mouse cursor.
Left-click button-same as double-clicking with left button on the mouse.
Right-click button-same as the right-click button on the mouse.

Pen Actions
· Press, Tap, Push Down with Pen tip-activates tablet icons, similar to left-clicking with
mouse.
· Double tap with Pen tip-is similar to double-clicking with mouse.
· Left-click-activates tablet icons, similar to double-clicking with mouse.
· Right-click-similar to right-clicking with the mouse.

Sleep Mode
The pen goes into sleep mode after a minute of inactivity. Touching the pen to the Q7RF
tablet surface or pressing the Left/Right buttons on the pen will reactivate it.

4.3

Drawing and Editing Tools
Pen Tool-use to draw
Highlighter-use to highlight
Line Tool-use to draw lines
Text Tool-use to create text
Laser Pointer-displays laser dot when using the pen
Absolute Position Mouse-displays arrowhead when using the pen and works as an
absolute position mouse
Mouse-operates pen with mouse functions
Keyboard-activates keyboard region

Select Tool
Selects drawing and text objects such as text boxes, shapes, lines, etc.
Qwizdom Mac Connect 2010
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Absolute Position Mouse icon on the tablet.

Mouse
Changes the pen to replicate the movement of a computer mouse.
1.
2.

Press the
Mouse Tool icon on the tablet.
Press the pen tip anywhere on the tablet's surface as if you were using a computer
mouse.

3.

Select another tool or press on the
off.

Absolute Position Mouse to turn Pen Tool

Drawing and Writing
Pen Tool is used to draw objects and write text.
1.
2.

Press the
Pen Tool icon on the tablet.
Place the pen tip on the tablet's surface to draw or write with the Pen Tool.

3.

Select another tool or press the

Absolute Position Mouse to turn Pen Tool off.

Highlighting
Highlighter Tool is used to highlight text and/or objects.
1.
2.

Press the
Highlighter icon on the tablet.
Place the pen tip onto the tablet's surface to highlight text and/or objects.

3.

Select another tool or press the

Absolute Position Mouse to turn Highlighter off.

Entering Text
The combination of the Text Tool and Keyboard allows you to create text without the use of
the tablet's keyboard.
1.
2.

Press the
Text Tool icon on the tablet.
Use the pen to create a text box on the computer screen by touching the pen tip
onto the tablet surface and drawing out the text box.

3.
4.

Press the
Keyboard icon on the tablet to activate the keyboard region.
Use the pen tip to enter the text into the text box using the keyboard on the tablet.

5.

Press the
tablet.

Absolute Position Mouse to deactivate the keyboard region on the

Drawing Lines
Draws straight lines with or without arrowheads.
1.
2.

Press the
Line Tool icon on the tablet.
Place the pen tip onto the tablet's surface to draw a line.

3.

Select another tool or press the

Qwizdom Mac Connect 2010
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Laser Pointer
Changes the computer cursor into a laser pointer.

5

1.
2.

Press the
Laser icon on the tablet.
Place the pen tip onto the tablet's surface to activate the laser.

3.

Select another tool or press the
off.

Absolute Position Mouse to turn Laser Pointer

Content Manager
Content Manager is where all created and imported activities are stored.

Create a New Folder
1.
2.
3.

Click the
Add Folder button.
Enter a name for the folder and click Done.
The folder appears in the Content Tree on the left.

Create a New Activity
1.
2.
3.
4.

Click the
Add File button.
Select Create and Add Live Editor File.
Enter a name for the activity and click Done.
The activity appears in the Content Tree on the left.

Create a New Answer Key
1.
2.
3.
4.

5.1

Click the black arrow to the right of the
Add File button.
Select Create and Add Answer Key file and enter a name.
Click Done and the answer key will appear in the Content Tree on the left.
Double-click the answer key file to launch the Answer Key window. See Answer Key
for more information.

Importing and Exporting
Importing Activities (.QAP and .QXA)
1.
2.

Go to the File menu and select Import Activity or Archive. The Open window
appears.
Select the Qwizdom activity you would like to import and click Open. The activity
will import into the Content Tree.

Importing External Documents
1.

Go to the File menu and select Import External Document. The Open window
appears.
Qwizdom Mac Connect 2010
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Select the file you would like to import and click Open. The external document will
import into the Content Tree.

Exporting Activities
1.
2.
3.

5.2

5.3

Select the activity you want to export.
Go to the File menu and select Export. The Export Activity window appears.
Choose the location to which to export your file and select Save.

Printing
1.

Select an activity.

2.
3.

Select
Click

Print. A preview of the activity will appear.
Print, located in the top right hand corner to print the activity.

Standards
Standards will auto-install during the first use.
1. Select an activity in the Content tree.
2. (Optional) Highlight a slide to apply standard to a single slide.
3.
4.
5.
6.

6

Click the
Standards button. The Standards window appears.
Select the standard at the level you want to apply to the slide(s).
Choose to apply standards to either the Selected Question or All Questions.
Click Link and then Close. The standards will appear in the Standards tab at the
bottom of the Content Manager window.

Live Editor
Create and present multimedia activities, lessons, and tests in Live Editor. Use premade
styles, tools, and templates or create your own.
1.

Go to the Programs menu and select Live Editor.
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Editor Toolbar

Creates new question slide

Text tool

Adds new slide to current slide set

Pen tool

Copies selected slide
Deletes selected slide
Launches Presentation Setup window

Line tool
Shapes tool
MathML

Activity Properties

Insert image and
multimedia

Change viewing mode (full screen, glass mode, integrated)

Deletes selected
objects

Selects objects on slide

Text Tool
Qwizdom Mac Connect 2010
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Click the
Text tool drop-down arrow and choose a styled font.
(Optional) Select Customize. The Customize Text window appears.
Click
Add. Scroll down and select the newly added font style. Set the font type,
size, and attributes.

Click
Delete to delete the custom font.
4. Close window when finished.

Pen Tool
1.
2.
3.

Click the
Pen tool drop-down arrow choose a pen style.
(Optional) Select Customize . The Customize Pens window appears.
Click
Add. Scroll down and select the newly added pen style. Set thickness,
color, and transparency.

Click
Delete to delete a pen style.
4. Close window when finished.

Line Tool
1.
2.

Click the
Line tool drop-down arrow.
(Optional) Select Customize. The Customize Line window appears.

3.

Click
Add. Scroll down and select the newly added line style. Set thickness,
color, and transparency.

Click
Qwizdom Mac Connect 2010

Delete to delete a line style.
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4.

Click OK to save the line style(s).

Shapes Tool
1.
2.
3.

Click the
Shapes tool drop-down arrow.
(Optional) Select Customize. The Customize Shapes window appears.
Click
Add. Scroll down and select the newly added shape. Set thickness, color,
and transparency.

Click
Delete to delete a shape.
4. Close window when finished.

Slides Tab
Displays thumbnails of all slides in the activity.

Media Tab
Allows you to search and use images in the Qwizdom database.

Templates Tab
Displays slide templates.

Qwizdom Mac Connect 2010
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Styles Tab
Displays slide styles.

6.1

Creating Slides
There are a couple of ways to open Live Editor.
· Go to the Programs menu and select Live Editor.
· Click the Content tab. Double-click any activity to launch Live Editor.

Information
Non-question slide (non-remote).

Qwizdom Mac Connect 2010

28

29

Qwizdom Mac Connect User Guide

1.
2.
3.
4.

Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
Click the Question drop-down list and select None as the slide type.
Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.
When the slide is complete, either go to the File menu, select Save, and close the
window; or click the

New Question button to create a new slide set.

Multiple Choice
Multiple choice question slide (up to six choices). Use with Q2RF, Q4RF, and Q5RF.
1. Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select Multiple Choice as the slide type.
3. Select the correct answer in the Answer field.
4. Setting the time limit and number of points is optional.
5. Enter text onto the slide; adding multimedia such as images, movies, or sound and
using templates and styles are optional.
6. (Optional)Create an answer slide. Click the
Add Slide button. A new slide will
appear within the slide set.
7. When the slide/slide set is complete, either go to the File menu, select Save, and
close the window; or click the

New Question button to create a new slide set.

Yes/No
Yes/No question slide. Use with Q2RF, Q4RF, and Q5RF.
1. Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select Yes/No as the slide type.
3. Select the correct answer in the Answer field.
4. Setting the time limit and number of points is optional.
5. Enter text onto the slide; adding multimedia such as images, movies, sound and
using templates and styles are optional.
6. (Optional)Create an answer slide. Click the
Add Slide button. A new slide will
appear within the slide set.
7. When the slide/slide set is complete, either go to the File menu, select Save, and
close the window; or click the

New Question button to create a new slide set.

True/False
True/False question slide. Use with Q2RF, Q4RF, and Q5RF.
Qwizdom Mac Connect 2010
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1. Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select True/False as the slide type.
3. Select the correct answer in the Answer field.
4. Setting the time limit and number of points is optional.
5. Enter text onto the slide; adding multimedia such as images, movies, or sound and
using templates and styles are optional.
6. (Optional)Create an answer slide. Click the
Add Slide button. A new slide will
appear within the slide set.
7. When the slide/slide set is complete, either go to the File menu, select Save, and
close the window; or click the

New Question button to create a new slide set.

Numeric
Numeric question slide. Single digit numeric answer allowed for Q2RF; nine digit numeric
answer allowed for Q4RF; and eight digit numeric answer allowed for Q5RF.
1. Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select Numeric as the slide type.
3. Enter the correct answer in the Answer field and press the Return key on the
keyboard to save it.
4. Setting the time limit and number of points is optional.
5. Enter text onto the slide; adding multimedia such as images, movies, or sound and
using templates and styles are optional.
6. (Optional)Create an answer slide. Click the
Add Slide button. A new slide will
appear within the slide set.
7. When the slide/slide set is complete, either go to the File menu, select Save, and
close the window; or click the

New Question button to create a new slide set.

Sequence
Place item choices in the specified order. Use with Q4RF and/or Q5RF.
1. Click the New
Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select Sequence as the slide type.
3. Enter the correct answer in the Answer field and press the Return key on the
keyboard to save it.
4. Setting the time limit and number of points is optional.
5. Enter text onto the slide; adding multimedia such as images, movies, or sound and
using templates and styles are optional.
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6. (Optional)Create an answer slide. Click the
Add Slide button. A new slide will
appear within the slide set.
7. When the slide/slide set is complete, either go to the File menu, select Save, and
close the window; or click the

New Question button to create a new slide set.

Multiple Mark
This question type enables two or more correct answers (up to six choices). Use with Q4RF
and/or Q5RF.
1. Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select Multiple Mark as the slide type.
3. Enter the correct answer(s) in the Answer field and press the Return key on the
keyboard to save it.
4. Setting the time limit and number of points is optional.
5. Enter text onto the slide; adding multimedia such as images, movies, or sound and
using templates and styles are optional.
6.

(Optional)Create an answer slide. Click the
Add Slide button. A new slide will
appear within the slide set.
7. When the slide/slide set is complete, either go to the File menu, select Save, and
close the window; or click the

New Question button to create a new slide set.

Rating Scale
Rating scale question slide (i.e. rating/opinions/polling using scales from 1-5, 1-10, etc.).
Use with Q4RF and/or Q5RF.
1. Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select Rating Scale as the slide type.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and
using templates and styles are optional.
4. When the slide is complete, either go to the File menu, select Save, and close the
window; or click the

New Question button to create a new slide set.

Text Input (only applicable to Q5 RF remotes)
Answer can be up to 30 characters long.
1. Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select Text Input as the slide type.
3. Setting the time limit and number of points is optional.
Qwizdom Mac Connect 2010
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4. Enter text onto the slide; adding multimedia such as images, movies, or sound and
using templates and styles are optional.
5. Enter the correct answer in the Answer field and press the Return key on the
keyboard to save it.
6. Creating an answer slide is optional. To create an answer slide, click the
Add
Slide button (optional). A new slide will appear within the slide set.
7. When the slide is complete, either go to the File menu, select Save, and close the
window; or click the

New Question button to create a new slide set.

Survey
Survey question slides do not have a correct answer. Use with Q2RF, Q4RF, and Q5RF.
1. Click the
New Question button. A blank slide will appear on the right and a
thumbnail preview of the slide will appear in the Slides tab on the left.
2. Click the Question drop-down list and select None as the slide type.
3. Enter text onto the slide; adding multimedia such as images, movies, or sound and
using templates and styles are optional.
4. When the slide is complete, either go to the File menu, select Save, and close the
window; or click the

6.2

MathML
1.
2.
3.
4.
5.

6.3

New Question button to create a new slide set.

Click the
Equation button. The Equation from Live Editor window opens.
Create an equation in the window.
Close window when finished.
The equation will appear on the slide as an object.
You can resize the equation by stretching the handles (click and drag).

Styles and Templates
Live Editor makes creating, editing, and applying styles and templates easy.

Applying Styles
1.
2.

3.

4.

Create a slide with or without text.
Click the Styles tab. You can either select a style to use by browsing all the available
styles or select a Category from the drop-down menu to select from a particular set
of styles.
There are two ways to apply a style.
· Click and drag the style to the slide (on the right) to apply.
· Press the Control key on the keyboard and click the style and select Apply to
Slide, Apply to Question, or Apply to Activity.
You are able to change the font style, size, and color (if applicable) after applying
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the style.

Creating Styles
1.
2.

Click the Styles tab.
Click Edit Styles. This will bring up the Styles window.

3.
4.

Click New. An untitled style row will appear.
Double-click on the untitled style to rename it and press the Return key to save it.

Create a unique name for each style to make it easier and more accurate for
importing, exporting, and applying styles.
5. Click each tab to customize text, shapes & media, and backgrounds of your newly
created style.
6. Create as many styles as you like. Click Done when finished.

Qwizdom Mac Connect 2010
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Text tab:
· Select font type, color, accent color (highlight), and style (bold, italic, and/or
underline)

Shapes & Media tab:
· Line thickness-determines the size of stroke applied to drawn shapes. To select
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thickness, click Line Thickness and select the thickness of the line.
· Fill Color- applies selected color to all shapes drawn on an activity. To select color,
check the Fill Color box (if Fill Color box is unselected, the default color will be
applied to any drawn shapes), and double-click the Color box.
· Border Color-applies selected color to outline/stroke of any drawn shape. To select
color, check the Border Color box (if fill Border Color box is unselected, the default
color will be applied to any drawn shapes).

Background tab:
· Background Image- check the Background Image button to browse for the image.
Click Open, and a preview will appear in the Sample window.
· Background Color- click inside the Background Color box to change background
color .
· Filter- applies a tint to your background image. Select the Content and Background
Filter Opacity.
· Layout- changes the color behind your content. Select the layout and how it should
be scaled on the slide.
The Content Filter Opacity will overwrite your Filter Color unless you scale the
size of content (see below for Content Scaling).

Edit Styles
1.
2.

Click the Styles tab.
Select the style you want to edit and edit the style settings. See Creating Styles
above for options.
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Click Edit Styles. The Styles window appears.
Click Done when finished editing.
Reapply the style to view the updated style.

Delete Styles
1.
2.
3.
4.
5.
6.

Click the Styles tab.
Select the style you want to delete.
Click Edit Styles. The Styles window appears.
Click Delete. A prompt will appear asking if you want to delete.
Click Yes.
Click Done to exit the Styles Window.

Import Styles
1. Click the Styles tab.
2. Click Edit Styles. The Styles window appears.
3. Click Import. The Import Styles window appears.
4. Select the .QSP (styles) file you want to import.
5. Click Open. The style will import into the Styles window.
If there is a style of the same name that already exists in the Styles window, it will ask you to
Overwrite or Ignore.

Export Styles
Exporting styles exports all styles as a .QSP file.
1. Click the Styles tab.
2. Click Edit Styles. The Styles window opens.
3. Click Export. The Export All Styles window opens.
5. Select the location where you want to save the styles.
6. Enter the name with which you want the styles to be saved.
7. Click Save. The styles are saved in the selected location.

Applying Templates
1. Click the Templates tab.
2. There are two ways to apply a template.
· Click and drag the template onto the slide.
· Press the Control key on the keyboard and click the template and select Load
Template.
Templates must be applied before adding text and multimedia to a slide.

Creating Templates
1.
2.
3.
4.

Create a slide with text and/or images and multimedia.
Click the Templates tab.
Click Create Template.
The template will be created and added to the Templates tab.
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Check the Filter for selected question type box to sort and display the templates
for a specified question type.
By default, there are no predetermined template categories. You must create categories,
see Creating Categories for Templates below for more information.

Creating Categories for Templates
1. Click the Templates tab.
2. Click the
Browse button that is located next to the Category drop-down. The
Categories Editor window appears.
3. Click Add and it will add an untitled category.
4. Double-click on the untitled category to enter a category name.
5. Click Close to exit.

6.4

Multimedia
Inserting an Image
1.
2.
3.
4.

Click the
Add Image button in the toolbar. The Open window appears.
Select the image and click Open.
The image will appear on the slide.
Grab and drag the handles of the image to resize to desired size.

Using the Online Media Search
1.
2.
3.
4.
5.
6.
7.

Click the Media tab.
Click Search (online).
Enter the keyword(s) in the Keywords field to search for an image.
Click Search.
Images matching the keyword(s) you entered will appear in the Media tab.
Select an image by dragging and dropping it onto the slide (on the right).
Grab and drag the handles of the image to resize to desired size.

Inserting a Movie
1.
2.
3.
4.

Click the
Add Media button in the toolbar. The Open window appears.
Select the movie and click Open.
The movie will appear on the slide.
Double-click the movie to play or stop it; or set the media properties.

Adding Sound
1.
2.
3.
4.

Click the
Add Video button in the toolbar. The Open window appears.
Select the sound file and click Open.
The sound file will appear on the slide.
Double-click the sound file to play or stop it; or set the media properties.
Qwizdom Mac Connect 2010
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Media Control
Media Control is used for presentation when the Q5RF Instructor Remote or Q7RF tablet
will not be used.
1. Go to the Tools menu and select Movie Controls. The Movie Controls window
appears.

· Play-black triangle
· Media Properties-multimedia settings

Media Properties

· Hide during presentation-options do not apply during presentation
· Show Movie Controls-displays a box of the movie and/or sound file names with play
and stop buttons.
· Play Continuously-repeats movie or sound file continuously when the slide is
displayed.
· Full Screen-plays movie in full size; displays sound in colors (best used with only the
Qwizdom Mac Connect 2010
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sound file on the slide).
· Play Automatically-plays the movie or sound file upon slide display.
· Delay ---- seconds before playing-enter number of seconds to pause before the
movie or sound file plays.

7

Participants

Creating a Participant List
1.

Click the Users/Participants tab.

2.
3.
4.
5.

Click the
Participant Wizard button. The Participant wizard will appear.
Select Create a new participant list.
Enter a name for the class and click Next.
In the Template Selection, select the template you would like to use (optional).

Remote ID is a default column within the templates. You do not need to create a
field for the Remote IDs, otherwise you will have two Remote ID columns.
Templates are commonly used fields to allow you to customize a participant list
you create or an existing one.
6. Click Next.
7. Select the different fields you would like to use and click Next. If you do not see a
field you would like in the participant list, you can create a customized field and
add it to your template.
8. Click Next. The participant list template will appear.
9. Fill in the fields and click Finish. The participant list will save into the
Users/Participants Tree.
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Importing a .CSV (Comma Separated Values) File
You can import .CSV class and convert it into Qwizdom participant lists (.QPL).
If you have a class list in Microsoft Excel® you would like to import, save it as a
.CSV file.
1. Click the Users/Participants tab.
2.
3.
4.
5.
6.
7.
8.

Click the
Participant Wizard button. The Participant wizard will appear.
Select Import CSV file.
Click Next.
Click Browse. The Open window will appear.
Search for the .CSV file you want to import.
Select the .CSV file and click Open.
Match the fields on the left to the fields on the right. If you don't know what the
field is, select None. Templates are commonly used fields to allow you to customize
a participant list you create or an existing one. You can also use the predefined
ones that are available.
9. If the information on the left are headers, check the First Record is Header box,
otherwise leave it unchecked. For example, if the imported information on the left
shows column headers such as Last Name, First Name, Remote ID, etc., those are
headers so you would check the First Record is Header box. If the information on
the left shows the actual name, Remote ID, etc., uncheck First Record is Header
because those are not headers.
10. Click Next when all the fields have been matched. The participant list will appear.
11. Click Finish. The participant list will save into the Users/Participants Tree.

Creating an Anonymous List
Before using an anonymous list, be sure you have the correct estimated number of
remotes set within the Configuration Preferences window. For example, if you create an
anonymous list with a hundred participants but only have eighty as the estimated number
of remotes, then not all remotes will register.
1. Select an activity, answer key, etc. to present.
2.
3.
4.

Click the
Present button. The Presentation Setup window will appear.
Click the Participant List drop-down list and select Anonymous.
Enter in the number of participants. The anonymous list has been created.

In Configuration Settings, check to make sure the estimated maximum number
of remotes reflects the number of the participants (or higher).
5. Click OK to begin presentation.

Editing an Existing Participant List
1.

Click the Users/Participants tab.
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2.

Select a participant list.

3.
4.

Click the
Participant Wizard button. The participant wizard will appear.
The Browse for and modify an existing list is selected by default. If the .QPL is
outside of Connect, then go to step 5. If it's a participant list that is located in the
Users/Participants Tree, then skip to step 8.
Click
Browse. The Open window will appear.
Search for the participant list you want to edit.
Select it and click Open. The name of the participant list will appear in the Name
field.
Click Next. You will be taken to Participant Field Selection. You may add new fields
or remove existing fields. If you do not want to change anything, skip to step 9.
Click Next. The participant list will appear.

5.
6.
7.
8.
9.

You can renumber the remotes according to the order of any column you
choose by going to Options (in the Participant Wizard window) and selecting
Autonumber Remotes.
10. Make the necessary changes and click Finish when done. A prompt will appear
asking if you want to overwrite or rename the participant list.
11. Select Overwrite if you want to save the changes to the original participant list, or
select Rename to create a new participant list.
12. Once finished, the changes to the participant list will appear in the
Users/Participants Tree.

7.1

Groups
Automatically organize students into groups based on Ability, Odd and Even Numbers,
Activity Score, or
Performance.

Creating Groups
1.
2.

Click the Users/Participants tab. The Users/Participants window appears.
Select the class for which you want to create groups.

3. Click the
Groups button. The Group Management window will open.
4. Select the Grouping Action and set the number of students per group. One group
may be odd
depending on the number of students in your class.
· Balance-groups students evenly. Each group has an equal number of high,
medium, low performing students.
· Group Similar-groups students by ability; high together, medium together,
low together
· Random-groups students randomly; groups may be odd/even.
· Group Size-specifies the number of students in each group.
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· Activity Score-overall grade on a particular activity.
· Predefined Ability Rating-participants' capability of learning. (Coming Soon)
5. Click Generate to create the groups.
6. (Optional)To manually alter groups, click a student and then drag and drop the
selected student
into the desired group
7. Click OK when finished.

8

Presentation
Activities can be presented with or without Qwizdom remotes.

Presenting an Activity
1.

Select an activity to present.

2. Click the
Present button. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the
results.
5. Select the options you would like available during presentation in the General and
Login tabs in the lower half of the Presentation Setup window.
6. Click Continue to begin the presentation.
7. Have the participants turn on their remotes.
8. Either the answer choices or a blank screen will appear on the remote, depending
on the question type.
9. Here are a few things you may execute during presentation:
· Display the public response graph or private graph
· Randomly call upon a participant
· Pose a spontaneous question
10. Go through the presentation until all the question slides are answered.
See Using Remotes in Presentation for description and troubleshooting of all the
remote LCD screen messages.
11. When all the slides have been presented, a prompt will appear asking if you would
like to finish the presentation or continue (review). Click Finish the Presentation to
exit the presentation.

8.1

Presentation Setup
There are many options you can apply to your presentation. Not all options will be
applicable.
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General tab:
Send right/wrong feedback to remotes after answering-remotes will receive a check
mark if answer is correct and an X if answer is incorrect. Remotes will receive both a
check mark and X to indicate that the response has been received if feedback is turned
off.
Allow participants to change their answer-checking this option allows participants to
change their answer for the current question slide.
Override question point value with global point value of ---- points-enter the new
amount of points that will be temporarily applied to the slide for that presentation.
Timer-you can select no timer, use the time set within the slides, or global timer by
entering the number of seconds for all slides in the presentation.

Login tab:
Require login by ID-checking this option will have remotes prompt participants to
enter their participant ID.
Show login screen-displays the login screen so the instructor can view the participants
that are logging in.
Add and allow unregistered participants-participants will be added to the participant
list by logging in with their participant ID. This option must be checked when using an
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Anonymous list. For the Anonymous list, participants will only log in with the session ID.
Deny login after ---- minutes-logins after the set amount of time will not be accepted.
Host--displays the host type (RF or HID)
Host Session--displays the host's default session ID
User Session--this is where you can enter your own session ID to use that overrides the
host's default session ID.
8.1.1

Saving Results
All results are saved as a .QRX file but can be converted into a .CSV (Comma Separated
Values) file.

Manual Save
1.
2.
3.
4.
5.
6.
7.

Click the
Present button. The Presentation Setup window will appear.
Select Browse for Save Location.
Click the
Browse button. The Save As window appears.
Select a location in which to save the results.
Enter the name with which you want the results to be saved.
Click Save. The file name and location will appear in the Save Results field.
The results will save in the selected location.

Auto-save
1.
2.
3.
4.
5.

Click the
Present button. The Presentation Setup window will appear.
Select Auto Save as 'Filename + List + Date.'
The Browse for Folder window appears.
Select the location and click OK.
The file name will contain the location, name of the participant list, date, and time
under the Save Results field.
6. The results will save when the presentation is complete.

Auto-Save to Results Manager
1. Click the
Present button. The Presentation Setup window will appear.
2. Select Auto-Save to Results Manager.
3. The results will save in the Results/Reports window when the presentation is
complete.
8.1.2

Remote Login
If you are presenting with remotes for the first time please see Remote Setup.
Logging in with IDs allows participants to use any remote. If you use participant IDs from a
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participant list, the ID will link the remote to the participant's information in the list.
To have participants log in, they must have a participant ID. Participant IDs are setup when
creating participant lists. (Go to Participant Lists for more information). Each participant
should have a unique ID assigned to his or her name.
· Participant IDs can only be numeric.
· The maximum number of digits allowed for IDs using the Q2RF remotes is 8.
· The maximum number of digits allowed for IDs using the Q4RF remotes is 9.
· The maximum number of digits allowed for IDs using the Q5RF remotes is 8.
· IDs cannot be used for more than one participant (IDs cannot be duplicated).
1. Select an activity or create one to present.
2.
3.
4.
5.
6.
7.

Click the
Present button. The Presentation Setup window will appear.
Select a participant list from the Participant List drop-down menu.
Click the Login tab.
Check the Require Login by ID option.
Checking the Show Login Screen is optional.
Select all other preferred options and click OK to present. The presentation will
begin.
8. The remotes will display User ID.
9. Participants will enter their ID and press the Send (double arrows) key.
10. Once everyone has logged in, begin the presentation.

8.2

Presentation Toolbar
This is the defaulted toolbar view during presentation:

Click

to expand the toolbar to display in full:
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Question Types
· Information-non-question slide (non-remote)
· Multiple Choice-multiple choice question slide (up to six choices); Use with Q2RF,
Q4RF, and Q5RF.
· Yes/No-yes/no question slide; Use with Q2RF, Q4RF, and Q5RF.
· True/False-true/false question slide; Use with Q2RF, Q4RF, and Q5RF.
· Numeric-Numeric question slide; Single digit numeric answer allowed for Q2RF; nine
digit numeric answer allowed for Q4RF; and eight digit numeric answer allowed for
Q5RF.
· Sequence-place item choices in the specified order; Use with Q4RF and Q5RF.
· Multiple Mark-this question type enables two or more correct answers (up to six
choices); Use with Q4RF and Q5RF.
· Rating Scale-rating/opinions/polling using scales from 1-5, 1-10, etc.; Use with Q4RF
and Q5RF.
· Text Input (only applicable with Q5RF remotes) Answer can be up to 30 characters
long.
· Survey-Survey question slides do not have a correct answer; Use with Q2RF, Q4RF,
and Q5RF.
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Presentation Features

Response Indicator

The response indicator displays the percentage of participants who have answered and is
enabled by default when a question slide is in view.

Timer
To view the timer during presentation, click the Timer drop-down list in the General tab to
view the timer options.
· The countdown timer counts appears in the right corner of the screen.
· Remotes will not be able to answer when time is up.
You can set the timer two ways; use the time from each slide or apply a new time to the
presentation. When you create a slide, you enter the amount of time you want the slide to
display.
To set a new timer for the presentation:
1. Click the Timer drop-down list and select Use Global Timer Value of---.
2. Enter the number of seconds.
3. Click Continue to present the presentation with the newly set time.

Points
You can set the point value two ways; use the point value from each slide or apply a new
point value to all the questions in the presentation. When you create a slide, you enter the
number of points the correct response will be awarded. Go to Creating a Slide for more
information.
To apply a new point value to all the questions in the presentation:
1. Check the Override Point Value with Global Point value of --- points option.
2. Enter the number of points.
3. Click Continue to present the presentation with the newly set point value.

Right/Wrong Feedback
This allows participants to see if their response is right or wrong.
1. Check the Send right/wrong feedback to remotes after answering box in the General
tab of the Presentation Setup window.
Feedback will appear on the LCD screen of the participant's remote during presentation. A
check mark will indicate a correct response, an X will indicate an incorrect response. If the
feedback is disabled, a check mark and X will appear on the LCD screen indicating that a
response was received.

8.3

Response Graph
During presentation, you can display a response graph to see the results of the question.
There are two response graphs you can display: the public response graph and the private
Qwizdom Mac Connect 2010

Presentation

48

graph.

Public Response Graph using the Q7RF Tablet
1.
2.

Press the
Public Graph icon on the Q7RF tablet.
The response graph will appear on the computer screen.

3.

Press the
graph.

Public Graph icon on the Q7RF tablet again to close the response

The public and/or private graph must be closed (follow step 3 above) before
moving to the next slide.

Private Response Graph using the Q7RF Tablet
1. Press the
Private Graph icon on the Q7RF tablet.
2. The response graph will display on the Q7RF tablet's LCD.
3. Press the
graph.

Private Graph icon on the Q7RF tablet again to close the response

Public Response Graph using the Q5RF Instructor Remote
1.
2.
3.

Press the / key on the Q5RF Instructor Remote.
The response graph will appear on screen for the participants to view.
Press the / key again to remove the response graph.

The public and/or private graph must be closed (follow step 3 above) before
moving to the next slide.
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Private Response Graph using the Q5RF Instructor Remote
1. Press the 0 key on the Q5RF Instructor Remote.
2. A bar chart showing the number of responses will display on the Q5RF Instructor
Remote's LCD screen.
3. Press the 0 key again to remove the graph.

8.4

Posing Spontaneous Questions
Spontaneous questions can be posed during presentation with the Q5RF Instructor
Remote or Q7RF tablet.

Pose Question (with Q7RF Instructor Tablet)
An activity must be in presentation mode before following these instructions below.
1. Click the
New Question drop-down arrow. A list of question types will appear
on the remote's LCD screen.
2. Use the up and down arrows to scroll through the list of question types.
3. Press the Enter key to select the question type you want to pose.
4. Select or enter the correct answer.
5. Click the
Pose icon.
6. Participants will either see the answer choices or a blank on their remotes. At this
time, they would select or enter their response and press the Send key to confirm.
7. Click the

Stop icon when time is up or after everyone has responded.

8. Click the
Public Graph icon to display the response graph. Click the Public
Graph icon again to close the response graph.
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Quick Pose Question (with Q7RF Instructor Tablet)
1.

Using the pen, touch on any answer on the bottom of the tablet.
· If you are posing a numeric question, touch the answer and then press the
Enter key to send it.
· If you are posing a survey (no answer) question, touch the Any icon for the
specific question type.

2. Click the
Pose icon.
3. Participants will either see the answer choices or a blank on their remotes. At this
time, they would select or enter their response and press the Send key to confirm.
4. Click the

Stop icon when time is up or after everyone has responded.

5. Click the

Public Graph icon to display the response graph.

Pose Spontaneous Question (with Q5RF Instructor Remote)
An activity must be in presentation mode before following these instructions below.
1. Press the New Q key on the Q5RF Instructor Remote. A list of question types will
appear.
2. Use the thumb pad to scroll through the different question types.
3. Press the Circle (thumb pad) key to select the question type you want to pose.
· The answer choices will appear for Multiple Choice, Yes/No, True/False, and
Multiple Mark. Select the correct answer and press the Send key.
· For Numeric, Sequence, and Short Answer, you will need to enter the answer.
Enter the answer and press the Send key.
· For survey questions (no correct answer), press the Send key without
selecting an answer.
4. Participants will either see the answer choices or a blank on their remotes. At this
time, they would select or enter their response and press the Send key to confirm.
5. After all participants have responded, press the Public Graph [ / ] key to display the
response graph. Press the Public Graph [ / ] again to close the response graph.
Spontaneous data will be recorded if you chose to save the results.

Pose Spontaneous Question (without Instructor Remote)
An activity must be in presentation mode before following the instructions below.
1. Click the
New Question drop-down arrow.
2. Select the question type you want to pose.
3. Select or enter the correct answer.
4. Click the
Pose icon.
5. Participants will either see the answer choices or a blank on their remotes. At this
time, they would select or enter their response and press the Send key to confirm.
6. Click the
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Games
There are different ways to display the game animations during presentation:
· Using computer mouse--click the right arrow in the Presentation toolbar to advance
to the next slide.
· Tablet--press the Show icon or advance to the next slide.
· Q5RF Instructor--press the right arrow key.

Baseball
Two teams are needed to play Baseball, which the program will automatically group by
remote numbers: odd number remotes vs. even number remotes. The outcome of the
game depends on the number of correct responses of each team for each question.
1. Click the
Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the
results.
5. Click the Present As drop-down arrow and select Baseball.
6. Select the options you would like available during presentation in the General and
Login tabs in the lower half of the Presentation Setup window.
7. Click Continue to start the presentation.
8. The Baseball setup window will display the odd and even remote numbers in their
respective teams.
9. A batter will appear for the team that is up; a question slide will follow.
10. Participants from both teams will send in their responses.
11. The outcome of each play is determined by the number of responses from each
team. The game will go in favor of the team with the most correct responses in the
least amount of time.
12. The winning team will be displayed when all questions have been answered or
when the game has ended.

Fast Track
Fast Track is a race car game in which points are rewarded based on the response time of
each remote.
1. Click the
Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the
results.
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5. Click the Presentation drop-down arrow and select Fast Track.
6. Select the options you would like available during presentation in the General and
Login tabs in the lower half of the Presentation Setup window.
7. Click Continue to start the presentation.
8. A question slide will appear.
9. Participants will send in their responses.
10. Points are awarded by correct responses sent in the least amount of time.
11. The winner will be displayed when all questions have been answered or when the
game has ended.

Mars Mission
Mars Mission is a space ship game in which points are rewarded based on the response
time of each remote.
1. Click the
Present button.
2. The Presentation Setup window appears.
3. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.
4. Click the Save Results drop-down arrow and select how you would like to save the
results.
5. Click the Presentation drop-down arrow and select Mars Mission.
6. Select the options you would like available during presentation in the General and
Login tabs in the lower half of the Presentation Setup window.
7. Click Continue to start the presentation.
8. A question slide will appear.
9. Participants will send in their responses.
10. Points are awarded by correct responses sent in the least amount of time.
11. The winner will be displayed when all questions have been answered or when the
game has ended.

Qwizdom Mac Connect 2010

53

9

Qwizdom Mac Connect User Guide

Results/Reports
You can generate reports using existing saved results.

1. Click the Results/Reports tab.
2. Click the
Report Wizard button. The Reporting Wizard window will appear.
3. Click Browse to search for the file for which you want to generate a report. The
Open window will appear.
4. The file type will be .QRX. Search for the file and select it.
5. Click Open.
6. Click the Choose Report to Run drop-down and select the type of report you want to
generate.
7. The report will appear in the window.

Saving a Report
1.
2.
3.
4.

Click the Print button in the Reporting Wizard after the selected report type is
displayed. The Print window appears.
Click the PDF drop-down and select Save as PDF. The Save window appears.
Enter the name with which you want the results to be saved.
Click Save. The report is saved as a .PDF.

Printing a Report
1. Click the Print button in the Reporting Wizard after the selected report type is
displayed. The Print window appears.
2. Click the Printer drop-down and select the printer to use.
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3. Click Print. The report will print to the printer you selected.

Report Features
· Attendance Report--displays participant information with their remote login time,
number of questions answered and total questions.
· Participant Group List Report--displays participant group information .
· Participant List Report--displays participant information.
· Overall Score Report--displays participant information with various point totals and
scores.
· Overall Answer Report--displays participant information, bar chart, question
responses, correct answer, and score.
· Summary Report--displays bar chart of class scores.
· Question Detail Report--displays participant responses on a selected question.
· Question Summary Report--displays bar chart next to each question.
· Standards Mastery Report--displays percentage of performance in meeting each
standard in the activity.
· Participant Comparison Report--displays an individual participant's results of an
activity.
· Participant Standards Report--displays how the individual participant met each
standard in the activity.
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Answer Key
Grade existing class worksheets, paper-based tests, and textbook material in the Answer
Key Mode.

Creating an Answer Key
1.
2.
3.
4.
5.
6.
7.
8.
9.

Go to the Programs menu and select Answer Key.
A window will appear for you to enter the name for the answer key.
Enter the name and click Done.
The AnswerKey window will open.
Click the + button on the lower left part of the window to add a question.
Click on the Type drop-down on the lower right of the window to select the
question type.
Enter or select the correct answer (if applicable).
Enter the number of points (if applicable).
Click Save when done. The answer key will save in the Content Tree.

Presenting an Answer Key
1. Click the
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2. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.
3. Click the Save Results drop-down arrow and select how you would like to save the
results.
4. Select the options you would like available during presentation in the General and
Login tabs.
5. Click Continue to begin the presentation.
6. The Paper-Based Activity Monitor window appears.
7. The participants will turn on their remotes at this time.
8. The answer key will load into the remotes and participants will begin to answer.
9. The progress can be tracked by following the activity on the Paper-Based Activity
Monitor window.
10. When all answer keys have been completed, click Close.

Instruct students to push the > right directional arrow key after answering
the last question to complete the answer key activity. The Q4 student remote
LCD screen will display "Complete...Y or N." Click the T(Yes) button to confirm
that they have completed the activity. If activity is not complete, the students'
scores will not be recorded. Screen display will vary depending on remote type.
11. A prompt will appear asking if you want to Don't Stop or Stop the session. Click Stop
to exit.
12. You will be taken back to the Answer Key Maker window.
13. The saved results will save in the location you selected.

Presenting Odd-Numbered Questions
1. Double-click the answer key. The Answer Key window appears.
2. Go to the Edit menu and select Select Odd Numbered Questions. Only the oddnumbered questions will be checked.
3. Click the
Present button.
4. Participants will only see and answer the odd-numbered questions during their
answer key.

Presenting Even-Numbered Questions
1. Double-click the answer key in the Content Tree. The AnswerKey window opens the
answer key.
2. Go to the Edit menu and select Select Even Numbered Questions. Only the evennumbered questions will be checked.
3. Click the

Present button.
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4. Participants will only see and answer the even-numbered questions during their
answer key.

Presenting Selected Question Numbers
1. Double-click the answer key in the Content Tree. The AnswerKey window opens the
answer key.
2. Check the question numbers you want to present.
3. Click the
Present button.
4. Participants will only see and answer the selected question numbers during their
answer key.
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Question Toolbar
Question Toolbar allows you to ask and create spontaneous questions and content. This
tool captures your desktop and sets it as a background to your presentation. For example,
if you have a document open that you wish to use as supplemental material to enhance
your presentation, or just simply want to add media or key points , the glass mode feature
will take a screen capture of your desktop and set the screen shot as your background.

Question Toolbar
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Exits the presentation

Pen tool

Slide navigator

Line tool

Create new question

Shapes tool

Indicates information slide
Text tool
Indicates question slide
Add equation
Indicates answer slide

Insert image

Copies current slide into slide set

Deletes a selected object on
the slide

Pose Questions

Switch views to Full Screen or
Integrated

Undo/redo

Expands/contracts toolbar

Selects objects on slide

Question Types
· Information-non-question slide (non-remote)
· Multiple Choice-multiple choice question slide (up to six choices); Use with Q2RF,
Q4RF, and Q5RF.
· Yes/No-yes/no question slide; Use with Q2RF, Q4RF, and Q5RF.
· True/False-true/false question slide; Use with Q2RF, Q4RF, and Q5RF.
· Numeric-Numeric question slide; Single digit numeric answer allowed for Q2RF; nine
digit numeric answer allowed for Q4RF; and eight digit numeric answer allowed for
Q5RF.
· Sequence-place item choices in the specified order; Use with Q4RF and Q5RF.
· Multiple Mark-enables two or more correct answers (up to six choices); Use with
Q4RF and Q5RF.
· Rating Scale-rating/opinions/polling using scales from 1-5, 1-10, etc.; Use with Q4RF
and Q5RF.
· Text Input (only applicable with Q5RF remotes) Answer can be up to 30 characters
long.
· Survey-Survey question slides do not have a correct answer; Use with Q2RF, Q4RF,
and Q5RF.
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1. Go to the Programs menu and select Question Toolbar. A prompt will appear for
you to enter the name of the activity that will be created during presentation.
2. Click Done and the activity will appear in the Content Tree.
3. Select the activity and click Present. The Presentation Setup window will appear.
4. Click the Participant List drop-down arrow and select what type of participant list
you would like to use.
5. Click the Saved Results drop-down arrow and select how you would like to save the
results.
6. Select the options you would like available during presentation in the General and
Login tabs in the lower half of the Presentation Setup window.
7. Click Continue to begin the presentation.
8. Have the participants turn on their remotes.
9. Use the Q7RF tablet to access the toolbar to create slides and pose questions.
10. When you are finished presenting, click the
Utilities button and select Exit.
11. The activity will save the in the tree of the Content Manager.

12

Software Updates
1.
2.

Close all Qwizdom software applications.
Click
Qwizdom Tools.

3
4.
5.

Select Check For Updates.
If there are any updates available, the Software Update window will appear and list
the release version, date, and the list of fixes.
6. Click Install Update. The update will download.
7. Once the update is done downloading, it is ready to be installed.
8. Click Install and Relaunch. The Install Qwizdom Connect window appears.
9. Click Continue in the Introduction.
10. Read the information in the Read Me section and click Continue.
11. Read the Licensing Agreement in the License section and click Continue.
12. Click Agree when the "To continue installing the software, you must agree to the
terms of the software license agreement" prompt appears.
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13. Select a destination to install Qwizdom Mac Connect in the Destination Select
section. Click Continue.
14. Click Install in the Installation Type section.
15. Your computer may or may not prompt you for a password (depending on
permission levels). Enter a password (if applicable) and click OK; or just click OK if
no password is required.
16. The update will begin to install.
17. Follow the wizard as it guides you to apply the update.
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